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Linux Mint - Cinnamon 
Install, Setup and Tips 

 

About This Document 

This document outlines the eight steps to install and setup the Linux 

Mint Cinnamon Operating System, on laptops used in the Missoula 

Public Library, Makerspace. Tips are included throughout the 

document.  This document can be used for installing and using Linux 

Mint by anyone on their own PC. 

 

These installation instructions were written to replace the 

Windows 10 operating system on Dell Latitude laptops used in 

the Missoula Publick Library - Makerspace. 
 

✓ Dell Latitude 7480  

✓ Boot-up function keys for this Dell laptop:  

o UEFI Setup = F2  

o USB Boot Menu = F12  
 

 

Updates to this document can be found on this website:  

(Log in with your Google account, then select the Linux User Group link.)  

https://sites.google.com/view/htt-helpful-tech-tips  

  

Date: 10/27/2025 

Dan Hubing    Email: parlors.grazer.4r@icloud.com  

https://sites.google.com/view/htt-helpful-tech-tips
mailto:parlors.grazer.4r@icloud.com
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Prerequisites 

1) Two USB flash drives: 

a. One  large, 1Tb USB  external drive for storage of Mint backup files and your 

personal files from the Windows 10 PC. (Best Buy or Staples have these.) 

b. One, >6Gb USB flash drive that you will make bootable and contain the 

program you will be booting into.  

2) Internet connection: WiFi or wired.  Have your network password handy. 

3) Identify your “Administrator Username and Password” you will use. 
4) Another thing you need to know is what the PC’s UEFI Setup and USB Boot 

Menu keys are, for your computer make and model.  (The UEFI is the program 

on your computer’s internal circuit board, which was once known as the BIOS.) 

The USB Boot Menu key is needed, since you’ll be booting your computer from a 
USB flash drive.  You can find this information from a simple internet search. 

Make ___________  Model _____________ UEFI Setup ___ USB Boot Menu ___ 

5) Dedicated time to the project.  Easily can take 4 hours to complete the 8 Steps. 

Just don’t rush it.  Take your time and come back another day to learn more about 
Linux by reading the Appendix sections.  (Remember how long it took to learn 

Windows, well now you get to go there that same learning curve again.) 

1) Save your files, check HW, create Disk image 

Tip #1: Copy this PDF file on your computer or If possible, set up a different computer 

or tablet as a 2nd computer, with this PDF file on it.  Then you will have easier access 

to the internet links when questions or problems arise during your installation.  (The 

Library has laptops you can use.) 

Tip #2: Use an external USB drive for a local copy of all your information you want to keep.  

You can use a cloud service instead of an external drive; but a local copy on a USB 

drive is more reliable than a cloud service.  Using an external drive will ensure an 

immediate safe location, with easy access.  Large external hard drives are available 

from many electronic stores.  This may be a good time to go and purchase one. 

  Photos, videos, and music files (Now’s a good time to clean these up!       )  

  Documents, spreadsheets, any work or personal files. They may be spread over 

different folders on your hard drive.  

  Open the Documents folder. Copy over “everything” that you want to keep.  
Don’t make the mistake, like I did, by just dragging the Documents folder to your 
USB drive; you’re probably just creating a shortcut. You need the contents, so 
make a new folder on your external drive and then drag over the contents of the 

Documents into your new folder.   

  Are your Passwords in a password manager program?  You should do an 

internet search to ensure that there is a Linux version of your manager program  
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  Using your browser export your Favorites, Bookmarks and Passwords to the 

external drive. Later you can import them. 

  Email addresses and passwords. (If you use Outlook, export the PST files.) 

  Open the Downloads folder to see if anything is there that you want to save. 

  App list: So, you see apps that you must have later in Linux Mint.  To see the list 

of apps in Windows; open Start > Settings > Apps.  Many Windows apps have 

alternatives in Linux.  Make sure you save any documents or information from 

these Windows apps. 

  Any unique hardware drivers you are using?  Things like Network adapters, 

Graphics cards or Printers or Scanners. 

  BitLocker Recovery Key: If BitLocker encryption is enabled you may need the 

key to access the drive later.   

▪ Visit: https://account.microsoft.com/devices/recoverykey  

▪ Login with your Microsoft account to retrieve and save the key. 

  Here’s a good tip. Take pictures, using a camera, or screen shots of your Desktop 

or File Explorer structure.  Then you can recreate that look  after the installation. 

  In a text file, type in any notes, setting changes, options or preferences that you 

want to duplicate, or any comments that you might want to remember later. 

 
  

https://account.microsoft.com/devices/recoverykey
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Checking Windows PC Hardware Compatibility with Linux 
 

1. Identify Your Hardware 

Before checking compatibility, identify your current Window’s system components. 

• Use Device Manager 

Press Windows + X > Device Manager: Then expand categories like Display 
adapters, and Network adapters.  You can take screen captures to save information. 

• Or use a free Tool, such as Speccy. https://www.ccleaner.com/speccy/download  In-
stall Speccy and then do a File > Print and print to Microsoft Print to PDF printer.  
(It’s a very large file; like around 104 pages!  Use your PDF Search feature to find 
your hardware components. 

2. Check Linux Hardware Compatibility 

Use online databases to check real-world compatibility: 
• Linux Hardware Database – https://linux-hardware.org/  
• Ubuntu Certified Hardware – https://ubuntu.com/certified  
• Linux Mint Hardware Reports – 
https://github.com/orgs/linuxmint/discussions/categories/hardware-reviews 

Perform internet searches to see if your hardware is compatible with your Linux Distro.  
 

3. Test with a Live USB 

This is the most reliable test. Boot from a live Linux USB (created with Balena Etcher, 
or Rufus) and select 'Try Linux Mint without installing.' Then test your: Wi-Fi, 
Bluetooth, sound, display, USB ports and any other specific HW components. 
 

4. Research Common Problem Areas 

Some components may require extra setup or proprietary drivers. These include 
Broadcom Wi-Fi cards, NVIDIA GPUs, fingerprint readers, and touchscreens. 
Search online for your specific model, e.g.: 

[your PC model] Linux Mint 

[hardware name] Ubuntu driver 

 

5. Run Compatibility Check from a Live USB distro 

Once booted into the live Linux session, open a Terminal and run: 

sudo lshw -short 

or install Hardinfo for a graphical report: 

sudo apt install hardinfo 
hardinfo 

Check for any 'unclaimed' devices, which indicate missing drivers.  If all hardware 
functions properly in the live session, your system is fully compatible with Linux. 

  

https://www.ccleaner.com/speccy/download
https://linux-hardware.org/
https://ubuntu.com/certified
https://github.com/orgs/linuxmint/discussions/categories/hardware-reviews
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Obtain your existing Windows 10 Key before Mint Installation 
 

The Microsoft Windows 10 product key is a 25-character alphanumeric code used to activate 

and verify a genuine copy of Windows.  You will need this if you ever re-install Windows 10. 

 

Obtain the Key, if Windows was preinstalled when the computer was purchased: 

1. Right-click on the Windows Start icon in the Taskbar 

2. Open Windows PowerShell as Administrator (It may say Terminal (Admin)) 

3. Type in, or copy, this terminal command exactly as is: (Note the Space locations.) 

(Get-WmiObject -query 'select * from SoftwareLicensingService').OA3xOriginalProductKey  

 

4. It will return the 25-character alphanumeric Key sequence:  

xxxxx-xxxxx-xxxxx-xxxxx-xxxxx 

5. Copy and save the key sequence on your USB device.  That way if you ever go 

back to Windows 10 on that PC, you have the key.  (There is a section in the Ap-

pendix of this document for “Reinstalling Windows 10” Appendix section.) 

How to obtain the Key if the Windows PC was a retail purchase: 

1. It was printed on a card or the box label.  It might have been emailed to you. 

2. It might also be known as a “digital entitlement”. 

  

Space
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Use Rescuezilla to make a backup “image” of your computer  

Preparation:   

1) Watch a Rescuezilla tutorial: https://www.youtube.com/watch?v=V-BtbSVma14  

2) USB flash drive (>4Gb) to be bootable and hold Rescuezilla (called USB1 here) 

3) USB flash drive (>500Gb) to hold the Rescuezilla backups files. (called USB2 here) 

4) Know the keyboard keys needed to boot your computer from a USB flash drive.  

You may need to do an internet search listing your PC make and model number to 

find out how to boot from a USB drive.  

Execution:   

Rescuezilla is the backup software that will copy everything on your Windows’s hard 
drive to an external USB drive.  If anything happens to your PC, you can always restore 

the hard drive, using the Restore feature.  

balenaEtcher is the software that will burn the Rescuezilla file onto a bootable USB 

drive. 

Step 1: Download the Rescuezilla and balenaEtcher (for Windows) software from 

https://rescuezilla.com/download.  Both will be in your Downloads folder. 

Rescuezilla = is the backup/restore program 

balenaEtcher = creates a bootable USB flash drive and copies the Rescuezilla file. 

Step 2: Insert USB1.  Then double-click on the balenaEtcher setup program in your 

Downloads folder. When balenaEtcher launches, you’ll use these three buttons: 
1) Click the Flash from file button, select Rescuezilla file from Downloads folder. 

2) Click the Select target button, select your USB1 flash drive. 

3) Click the Flash button to make the USB drive bootable and copies the Rescuezilla file 

over to it.  

4) When balenaEtcher is completed, you can delete both programs from your Downloads 

folder.  Then make a backup. 

 

Make a backup:  

(Repeat this backup process each time you perform a backup.) 

Insert the USB1 bootable drive. Reboot the PC and boot from the USB1 drive (F9 for 

HP Envy laptop). This will launch the Rescuezilla software. Wait until you see the 

Backup and Restore buttons.    
 

Insert the USB2 backup drive. Select Backup.  Now you’ll need to select quite a few 
options, read carefully and go slowly. (There is a Back button if you need to change the selection.) 

 

When finished; click on the small “display” icon in the lower left-hand corner.  Select 

Shutdown, then in the popup window, select Shutdown.  This shuts off power to your PC 

and allows you to unplug both USB drives.  Reboot into Windows.   

Good job: you now have a full backup image of your PC. (Use Restore to restore the 

image if every needed.) 

  

https://www.youtube.com/watch?v=V-BtbSVma14
https://rescuezilla.com/download
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Final thoughts before continuing with the Mint installation: 
 

Stop here a minute and really understand that your computer will be rebuilt from the 

ground up – just not with Windows, but a whole new operating system; Linux Mint 

Cinnamon version. 

 

Give yourself some time to look over your Windows 10 computer again, to see if you 

need to add any information to your “To use Later” list. 
Make sure you have an “image” of your Windows computer harddrive, in case 
something really goes wrong and you want to “restore the image” back to you PC. 

 

After the installation is complete, you can move these files into the new Linux system.   

 

 

Another smart move would be to make a full image backup of your current system. 

(This document describes using Rescuezilla to create full computer images.) 

 

The reason for this is that the computer hardware may have issues with running 

Linux. We do know that Linux runs on most computers but if yours is too “new”;  
there may not be adequate drivers available. For example, the latest “M” chip in 
Apple products or the latest NPU chips that are found in Copilot+ Windows PCs. If 

you question your computer hardware compatibility, you should do some internet 

research and reach out to the Linux community.  

 

 

 

Once you are comfortable that you have everything off the Windows 

PC, you may continue with installing Linux Mint – Cinnamon Edition 

 

.  
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2) Install Linux Mint: Cinnamon Edition 

Overview: You will be downloading the Linux ISO file to your PC.  Then create a “bootable” 
USB drive (~6 Gb size) and copy the ISO file to that USB.  Then reboot from the USB. 

 

Tip: Copy this PDF file on your computer or If possible, set up a different computer or 

tablet as a 2nd computer, with this PDF file on it.  Then you will have easier access to 

the internet links when questions or problems arise during your installation.  (The Library 

has laptops you can use.) 

Make sure you know what Function keys for the EUFI Setup and USB Boot Menu 

for your specific computer.  You need these to continue with the installation of Mint. 
 

1. Launch a web browser on the Windows 10 computer 
 

2. Download Linux Mint’s Cinnamon edition, ISO file: 

➢ Go to: https://Linuxmint.com/download.php  

There are two possible versions of Linux Mint.  If you have at least 4 Gb of ram, 

which most PCs do, then you’ll download Cinnamon.  If your PC has 2Gb of RAM, 

then you should download the lighter version; Xfce. 

➢ Click on the Download button for the Cinnamon Edition,  then scroll 

down and click on one of the USA locations, like Harvard School of 

Engineering. (It’s a 2.8Gb ISO file.) 

➢ This downloads the linuxmint*.iso file into your Window’s Downloads folder 
 

3. Create a bootable USB drive for the new LinuxMint Cinnamon ISO file 

➢ Insert your USB flash drive. 

➢ The Rufus app, which runs on your Windows computer, is used to create 

a bootable USB drive that will contain the Mint ISO file.  
 

1) Go to https://rufus.ie  (Don’t click on any Ads, there are lots of them!) 

2) Scroll down and select the “latest” rufus*.exe Standard for Windows link. 

3) In the Downloads folder, double-click on rufus*.exe 

4) In the Drive Properties window: 

a. In Device = select your USB flash drive 

b. In Boot Selection, click the Select button and select the Mint 

*.iso file from the Downloads folder. 

(Leave all other Rufus options at the default value.) 

c. Select Start to begin (If a Download required dialog box opens, 

select Yes.)  This can take 15 minutes or so. 

d. It’s finished when the Status bar shows READY. 

e. Keep the USB stick in the computer.  You’ll be directed to 
remove it later. Close the Rufus window. 

 

4. Boot into “UEFI Setup” to disable Secure Boot  (F2 on Dell Latitude 7480) 

https://linuxmint.com/download.php
https://rufus.ie/
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(Note: UEFI is the firmware on your computer’s internal mother board.) 

Linux Mint may not install properly with secure boot enabled. 

It should be disabled in UEFI prior to installing Linux Mint iso file 

➢ Restart the PC, go into EUFI Setup and locate the Secure Boot 

option. Then disable Secure Boot.  To save this change, when you 

Exit, it should ask if you want to save any changes; select yes. 
 

5. Boot up into “USB Boot Menu” to load Mint. (F12 on Dell Latitude 7480) 

➢ Restart the PC. In a few seconds the Dell icon is displayed, depress F12 

(On the Library’s Dell PCs, the F12 key is depressed repeatedly when the 

Dell icon is displayed. Refer to your USB Boot Menu key for your specific 

computer.) 

 

➢ Select the name of your USB Flash drive device 

➢ Select “Start Linux Mint…” the top of the list of options. 
 

➢ In a couple minutes, look for a desktop icon that says Install Linux Mint.  

Double-click on it.  Select the options that fit your installation, including the 

WiFi setup. Then click Continue. 

• When the “Network connection type” window opens, select the type 
you will be using, usually WiFi, then your network name and password  

• When the “Installation Type” window opens, select Erase disk and 

install Linux Mint.  (This wipes out Windows and only keeps Mint.) 

 

➢ Continue with the initial information. 

i. Where are you? Time zone, click in Denver (Mountain time zone) 

ii. Who are you?  (You should use different names on your personal system) 

1. Your name: makerspace 

2. Username: Makerspace (Admin username – no spaces) 

3. Password = mko0lp\\ (Admin password – 8 characters) 

(Note: You can always change the name & password information later by going to:  

System Settings > User and Groups.  Write down your admin name & password.) 

iii. Installation begins. Read through the information screens to help 

learn how Mint works.  Select Restart Now when asked.  

When directed, remove the USB drive. 

 

6. Success! – It launches automatically into Linux Mint, for the first time: 

➢ Log in with the “administrator” username and password 

➢ The Welcome screen will launch. You can now go to Step 3 and configure 

your Mint options. . 
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3) Recommended Mint configuration options 

The initial Welcome to Linux Mint Welcome window is an easy way to initially configure Mint. 

You can uncheck the “Show this dialog at startup” checkbox.  Then, select the “Let’s go!” button.  
 

In the First Steps group, you will set up the initial configuration of Linux Mint.  (There 

is a Welcome Screen app, that is the same as the Welcome to Mint program, it’s 
available for future changes.)  The configuration settings in this document are for the 

Makerspace’s public  computers—your own personal computer may have different 

configuration settings.  Everything is easy to configure, so have fun! 

 

If you close the Welcome window, you can relaunch it be clicking on the Menu button 

and search for “Welcome Screen”. 
 

Welcome Screen recommended configuration changes: 

Select Let’s Go to get started setting up Mint. (Click the Launch button for each section) 

Desktop Colors – (This edits the Theme displayed by the Desktop) 

1. In Style: select Mint-L  

2. In Appearance: select Light 

3. In Color: select the gray colored ball. 

(Later on, you can try the Advanced settings button for different “Themes”.) 

Notice there is no “save” or “close” buttons, like there were in Windows.  So just 

select the x in the top right-hand corner, to close and go back..  

System Snapshots – (These are backups of the current Mint system configuration.) 

1. Snapshots require Administrator rights, so log in with your Admin pw. 

2. Update Manager will launch if “updates” to Mint are available. Install them. 
3. Keep the Snapshot Type of RSYNC. 

4. Select Create to create a new “Timeshift” snapshot. 

5. Select Settings > Schedule; None for the Library. (Twice monthly for home use.) 

Driver Manager – this app checks for driver updates, select any that are needed. 

Update Manager – Select Install Updates when they exist.  (There is an option to 

use a “local mirror” for your updates, Just select No or ignore the message.) 
You will need to log in with your Admin pw.  This app manages system 

packages, Standard Package (APT) installed apps, and security patches.  More 

information is found in the section “7) Updating the software” in this document.   

System Settings – Here are the Appearance, Preferences, Hardware and Administration 

options. You will be coming back to System Settings quite often! 

Appearance section: 

1. Backgrounds: In the Wallpapers group select Sparkling. . 

Notice: To return to the System Settings window, select the “left arrowhead” button. 
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2. Font Selection: Change 10 to 12 for Font’s selections, except make the 

Window title font 14.   

3. Font Settings: Change Text scaling factor to 1.2 and Hinting to Full.  

Preferences section: 

1. Accessibility: In the Visual tab, turn On the Enable Zoom and then change the 

Mouse wheel modifier option, to, <Control>.  Select the Keyboard tab, turn on the 

“Use visual indicator for Caps & Num Lock”. 
2. Date & Time: Turn Off the Use 24h clock  

3. Desktop: Turn on; Home, Trash and Mounted Drives (The Mounted Drives 

option will then show your USB drives as you plug them in. Very handy.) 

4. Panel: (The Panel is Mint’s Taskbar) In Panel height, slide to 50.  In the 
Panel Appearance section, make sure the Left Zone (this controls the left-
side Panel icons) is selected and change the Colorized icon size to “Scale 
to panel size exactly”.  Then select the Right Zone tab (this controls the 
right-side Panel icons) and change the Symbolic icon size to 30. 

5. Windows: Behavior tab, in Draggable border width: slide to halfway. In the 
Location of newly opened windows options, select Automatic. 

 

Hardware section: 

1. Mouse and Touchpad: Mouse tab: slide the Pointer “size” to ¾ of scale 

2. Power Management: 

a) Power tab: In the When lid is closed: set “both” to Shut Down Immediately  

b) Brightness tab: set Dim screen after inactive: to 10 minutes  

3. System Info:  

a) Operating System: This shows you your system information. 

b) Upload system information = This shows you the “full system details”. 
 

Administrative section: 

1. Firewall: For some reason, the Firewall defaults to Off. To turn it on, slide the 

Status to On. The Profile defaults to Home, which is fine for personal use, but 

for the Library Makerspace use, we changed it to Public.  

(Edit other Firewall options for your personal use, if you have firewall 

knowledge.  It’s beyond the scope of this document.) 

2. Login Window: In the Users tab are the options where you can select one of 

your users to automatically login.  You can edit these if you have other “users”.   
 

Close the System Settings app by clicking the top-right corner X. 

Miscellaneous configuration changes 

1. Right-click on Battery icon located on the right side of the Panel: 

o Select Configure; this loads the Power Manager window 

o Set Display to “Show percentage and time remaining” 
2. In the Menu; select the Administration category, right-click on Software 

Manager (or Search for it), then select Add to panel.  This will add the 

Software Manager program icon to the Panel. 
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3. In the Menu; select the Office category, right-click on LibreOffice Writer; 

(or Search for it), then select Add to panel. (LibreOffice is a free Microsoft 

Office equivalent and easily works with Microsoft Office files.)   

The following steps will modify LibreOffice Writer to appear like Microsoft Word. 

o Launch LibreOffice Writer. 

o Under the View tab, select User Interface: select Tabbed, then Apply 

to All, then close. Also in View tab: select Menubar, then under 

View, select rulers > vertical rulers. 

o Click in the top-right-hand corner’s “empty box” or the box with 

the“3-line hamburger icon inside”; whichever is present.  

o Select Options: Then under the LibreOffice group, click View. In the 

Icon Theme, select Colibre (SVG) and change the Tollbar: field to 

Extra Large, the Notebookbar: field to Large and the Sidebar: field to 

Large. Click OK to save.  Close LibreOffice Writer now. 

Firefox Browser Configuration: 

Firefox Web Browser is the default browser used by Linux Mint. 

Launch Firefox, skip any “Welcome to Firefox” windows.  Then make these changes. 

o Go to www.Tinkercad.com, click the “star” in the address bar to add it to 

the Bookmarks Toolbar. 

o Go to www.thingiverse.com click the “star” in the address bar to the 

Bookmarks Toolbar.   

o Go to: www.Duckai.com , add this is a Bookmark Toolbar. This is a free AI 

chatbot that does not require a password. It’s provided by DuckDuckGo, which 

is a privacy focused internet company.  

o Right-click on “3-line” icon, in Bookmarks Toolbar, select Always Show 

Files Configuration: This is Mint’s file manager program.   
Launch Files (click on the “folder” icon in the Panel) or from the Menu 

Select the Edit menu, then Preferences: 

o Views: For Default View, change View new folders to List View 

o Behavior: In Trash group, check Ask before moving files to the Trash 

o Preview: For Tooltips, check all three Show … checkboxes 

To show a “Tree View” in the Sidebar: View > Sidebar > Tree. (or use the Show Places 

& Show Treeview icons on Files’ lower left-hand corner.   

http://www.tinkercad.com/
http://www.thingiverse.com/
http://www.duckai.com/
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4) Information on installing Linux app programs 

The location we’ve used for years to install programs in Microsoft Windows included 

the Microsoft Store or going to the program’s website and downloading an .EXE or 

.MSI file.  In the Linux world the downloading process is very similar.  For Linux Mint, 

the Software Manager app is the equivalent to the Microsoft Store.  In Mint’s Software 

Manager, you’ll select a “package type” to install the actual program.  If the program 

is not found in the Software Manager or if you want the later version, you can go to 

the program’s download website page.  There, you may see options to download a 

Linux version.  Linux file package formats available may be *.deb and *.AppImage, or 

even a Linuz zip file.    

 

Another download library of programs is known as “hub” websites.  For example, the 

latest Arduino program version is available from a  hub, known as Flathub.   

 

Programs with the .deb extension are easy to install.  Simply download it.  Then 

double click on it to install it.  When the installation is done, you can delete the *.deb 

file, since the program code is installed in Mint. 

 

Programs with the .AppImage extension, when downloaded, will need to have its 

Properties tab edited to set it to “executable”. Then you should be able to double-click 

on it to “run” the program. The AppImage file is the executable program, so you 

should not delete it.  

 

As you can see, programs available for Linux computers are downloaded and 

installed in a variety of ways.  (You may want to research to learn more about these 

packages.  The Appendix has a list of Tutorials to help you learn Linux. 

 

Using Mint’s Software Manager: 

Software Manager is Mint’s “app store”, where you can find and download many 

apps.  Tip: There is a Search button in the top left-hand corner to help find apps. 

 

Launch the Software Manager app from the Menu  

Open the Menu, launch the Software Manager, then search for your app you wish to 

install; but before you select the Install button; you should check out the “package 

type” button, located below the “Install” button.  Programs come within different 

packages, sometimes. This is where you can select which software package you will 

use for the downloading of the app. If only one package is present, just select Install; 

but if there are more than one available, then select each and note the program’s 

version number.   

 

If you select “System Package”, you are choosing the default “*,deb” package 

type.  (“deb” stands for Debian type)  The System Package option may not have the 
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latest version of the app you wish to download, so if available, you should check out 

Flatpak package option. 

 

If you select “Flatpak”, you are choosing this as your download package type. (You 

only see this if the app itself is available for download from the Flatpak software hub 

store. Usually, Flatpak offers a newer version of the app, so it’s normally the one to 

choose. To locate the app’s version number, select each download package button 

and then scroll down to locate the Version #.  Choose your download package, then 

select Install.   

 

If no Flatpak options are available – don’t worry! 
If for some reason you don’t see Flatpak as a download option; that means that the 

app is not available from the Flatpak repository, which is known as Flathub.   

For more information on Flathub, check out their website: https://flathub.org.   

Flatpak – What is it? - This is a software package installer. It adds another installer 

option, besides the standard APT installer from Mint.  (Usually, you would choose the 

installer that has the latest “version” of the app.  To check, select the installer and 
then scroll down to see the version number of the app you are going to install.) 

Install by using this Terminal command: sudo apt install flatpak 

 

Can’t find your app in Software Manager?   
Then Use a browser to locate the download site for your program. You may need to 
research the options available.   
 

  

https://flathub.org/
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5) Install 3’rd party app programs 

The apps below are programs used in the Library’s Makerspace. Of course, for your own 

personal computers, your app selections may differ.  After these are installed, you may 

want to install the programs that you used in the previous Microsoft Windows system.  

Also, copy over any personal data files that you backed up prior to installing Linux Mint. 
 

➢ GIMP – from Software Manager (a common photo editing program) 

1. From the Software Manager, search for GIMP.  (You will notice there are 

lots of Gimp plugins, doc and other Gimp add-ons, to choose from - we 

only want the Gimp app.  If you’re still not sure what to choose; select 
one, then scroll down and select Homepage. That helps sometimes.) 

Notice that the System Package is an older Version than the Flatpak 

version. Install using the Flatpak package since it has the latest version.  

Continue to accept the Additional software. 

In the “Additional software will be installed” window; you will see every 

library and dependency program that GIMP will need.  Using a Flatpak 

package, all dependencies are included in the download.  System Package 

downloads will interface with existing Linux dependencies already installed. 

2. Once installed, search for GIMP in the Menu.  (Mint will sometimes 

place apps withing a specific category, in this case it’s in the Graphics 

category or of course it’s under All Applications as well.)  Select GIMP 

to launch it. 

Tip: Notice the long name of the program, abbreviated it’s GIMP.  You may 

want to right-click on it and select Properties to rename it to GIMP.  If you want 

to use this program often, you may want to add to Panel or Desktop. 

 

➢ Google Chrome – (Google Chrome browser) 

Chrome is not found in the Software Manager. Get it from Google. 

1. From Firefox go to https://www.google.com/chrome/  

2. Select the Download Chrome button 

3. Select 64 bit .deb (Mint Cinnamon is actually based off of Ubuntu, 

hence select the deb package), then Accept and Install 

4. After the download, open the Downloads folder and double-click 

.deb.  Then click Install Package. Login with admin password. 

5. Open the Menu, in the Internet category is Google Chrome.  

(Note: some standard users may need to login with the admin 

password to open Chrome.   

If you’re a Google apps user, just log into Chrome and click on the 3x3 

button; then use Drive, Docs or any other Google app. 

 

https://www.google.com/chrome/
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➢ Inkscape – from Software Manager (Makerspace’s Laser cutter software) 

Download from the Software Manager using the Flatpak package since 

it has the latest version.  Continue to accept the additional software. 

Tip: One thing to keep in mind when saving files made by apps like 

this.  The default “Save As” folder is the “username” folder, under 
“home”.  You probably should make a new folder named: Inkscape and 

use that as your Inkscape document location folder.   

 

➢ PrusaSlicer – from Software Manager (Makerspace’s 3D printer slicer) 

1. Download from the Software Manager, using the Flatpak package. 

2. Right-click on PrusaSlicer in the Menu.  Select Add to Desktop 

3. Launch the app from the Desktop. 

4. Tip: Launch PrusaSlicer and save a test file to identify the saved location. 

 

• Arduino – from the Arduino website (Makerspace’s robot controller software) 

You will be downloading the Arduino “AppImage” file, set it to 

executable, then execute it to use Arduino.  The AppImage file is a 

package that is “self-executing”.  Once you change the execution setting, 

all you need to do is double-click to run the program. 

1. Go to https://www.arduino.cc/en/software/  

2. Before select the Download button, make sure it states Linux Applmage… 

option.  Then select “Download” from the next couple screens.   
3. The Arduino…..AppImage will download into the 

/home/<username>/Downloads folder. 

4. Open Files and go to the Home folder. (Tip: In Files; select View > 

Sidebar > Tree.) 

5. Since an AppImage file is the actual program to execute, you 

should move it from the Downloads folder, into something like a 

/Programs folder.  Select File, display the <username> folder; then, 

under File menu select Create new Folder. Create a MyPrograms 

folder under the <username>.  (You could also right-click on the 

Files app to open the right-click menu, which as common 

commands.) 

6. Copy the Arduino…AppImage file from /Downloads to /MyPrograms. 

(Tip: an easy way to copy files is to have two File apps open.  So, under 

the File menu option, select New Window.  Move the two Files app 

around to make it easy to drag the AppImage from Downloads into 

MyPrograms. (Or select View > Extra Pane) 

7. Now set the AppImage file to be executable.  Right click on the 

Applmage file and select Properties.   

a) In Properties, select the Permissions tab. 

https://www.arduino.cc/en/software/


Linux Mint Install Setup and Tips _10.27.2025.docx  Page 18 of 41 

b) In Permissions, check the Allow executing file as program. This 

will allow the program to run when double clicked. 

c) Close (lower right-hand corner) the Properties window  

8. Double-click on the Arduino program.  It should launch. 

Note: since AppImage directly launch, they are not “installed” like 
*.deb or Flatpak packages.  . But unlike DEB or Flatpak installs, 

AppImage files aren’t assigned to a Category in the Menu.   

 

Here’s how to do Add the Arduino to a Menu Category. 

1. Right-click on the Menu; select Edit menu. 

2. In the most left column are the Menu’s categories. Select the 

Programming category, since Arduino IDE is a programming 

software tool. 

3. Select the New Item button.  The Launcher Properties dialog 

box opens.   

4. In the Name field; type in Arduino IDE 

5. In the Command field, select the Browse button and browse 

to the MyPrograms folder where the AppImage is located.  

Click on the Arduino…AppImage file and then select OK. 
6. Change the default Icon, by clicking on the icon.  Then in the 

Choose an icon window, search for Arduino and select one 

of the options. 

7. Finally, select OK in the Launcher Properties dialog box to 

save and close. 

8. Close the Main Menu editor window. 

9. Test out your new Menu entry.  It should be under the 

Programming category, and you should be able to search for it. 

10. You can right-click on it and add it to the Desktop, if you wish.   

To make sure Arduino IDE can upload a program to an Arduino circuit board, 

proceed to the next page. 
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Using Arduino IDE for the first time with an Arduino board plugged in. 

 

When you do your first Upload to an Arduino board, it may not be listed , you may 

need to add the Arduino AVR Boards library from the Boards Manager… 

1. Select Boards Manager… 

2. Search for Arduino UNO in the Boards Manager search field. 

3. Install Arduino AVR Boards 

If the Port selection is grayed out, then select Reload Board Data. 

1. Don’t select a port that has tt /dev/ttySxx (The xx may be a number.) 

2. Do Select a port that has USB in its name, such as /dev/ttyUSB0                   

(or ACM in its name). 

If for some reason you get a “Permission denied” compiler error and only the ttSx port 

is available; try these fixes. 

1) Make sure the Username you are using is assigned to the dialout group.  

This group gives permission to use the Serial Ports. (Restart after making the 

changes.)  Then try another Upload from Arduino.  If the Ports are still not 

correct, try the 2’nd fix. 
 

2) You need to run the Terminal command:  sudo apt remove brltty.  

Don’t forget to hit Y for yes in Terminal. 

(This command will uninstall the BRLTTY software. The brltty app takes 

over control the COM ports; so, it needs to be removed.  Then Arduino 

can gain access to the COM ports.) 
 

 

If you get this Compiler Error about “access permissions”, then try this Terminal 
command:  sudo usermod -aG dialout $USER 

This command ensures the logged in user is added to the dialout (serial ports) group.  

Log out and then try another Upload to see if the compiler error occurs again. 
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6) Add a new User  

It’s always wise to have a “Standard” user for your daily work and an “Administrator” user for 

any system work.  Below are instructions for adding a Standard User. 

 

Add a standard user: 

1. Launch User and Groups. Login with your Administrator password. 

2. In the Users tab, select the Add button. 

3. Use this username information: 

Keep the Account Type as Standard. 

Full Name = User1, and Username = user1. Then click Add. 

The syntax rules: For Full Name is anything, but the Username 

are all lower-case letters, no spaces, numbers are ok. 

4. Select your new user1’s username, in the Users tab. 

a) There is No password set for User1 since the Library’s 
Makerspace has no password requirements. So, leave it as is.  

b) Select the Groups listed to open the Group List. 

c) Check to add these groups: dialout, makerspace (the admin 

username), and users 

d) Select OK and then close the User and Groups window. 

5. Select Menu, then in the left side column (known as Favorites), 

click on the “circle with line on right-side” icon.  That’s the Log Out 

button. Select the Switch User button and log in with “user1”. 
 

6. Configure the new user:  

The first time you log in with a new username the Welcome window 

opens.   

 

Refer to the section “3) Recommended Mint configurations 

options” in this document to make suggested changes for this new 

user as you did with the Admin user. 

Return here after you are done with that section. 

 

7. Configure apps for the new user: 

Create Desktop shortcuts for apps installed by Software Manager. 

a) In the Menu, search for PrusaSlicer. Right-click on it and 

select Add to desktop. 

b) In the Menu, search for Inkscape. Right-click on it and 

select Add to desktop. 

c) In the Menu, search for Arduino IDE. (If the Arduino app is 

not in the Menu you may need to follow the instructions for 

adding Arduino to the Menu, from the install instructions 

above.) Right-click on it and select Add to desktop.   
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Notice how easy it is to add these apps to the desktop.  That’s 
because they were installed using the Software Manager.  If you 

open the Properties of these apps (Right-click and select 

Properties), you will see the word “Flatpak” in the Command line.  
That means the app was installed using the Flatpak install package 

from the Software Manager. 

 

 
Note: Some Rules for executing apps by a standard user: 

• A standard user does not have all the privileges that the administrator user has. 

• Users can run applications installed system-wide via the Software Manager (APT 

or Flatpak).  But they cannot modify or delete system-wide apps; only the Admin 

password has those rights. 

• Users cannot run AppImage files stored in other users' home directories unless 

they are explicitly granted permission. 
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7) Updating software 

If updates to the Mint operation system including security and driver updates as well 

as 3’rd party apps, an “Update” notification icon is visible in the panel. (You can also 

launch the Update Manager app itself, to manually check for updates. Open the 

Menu and then search for Update Manager.)   
 

Update Manager Tutorial: https://itsfoss.com/linux-mint-update/  
 

The type of update action depends on how an app was installed.  There are 

three common software app packages that are used in a Linux system: System APT, 

Flatpak and AppImage. For System Package (APT) and Flatpak apps, the update is 

easy using Update Manager.  AppImage apps are more complex, requiring manual 

installation and manual updating. 
 

The APT, or System Package in Mint, is a *.deb file type.  The “deb” stands for a 

“Debian package” installation file and is used to install programs on a “Debian Linux” 
system, like what Mint is.  Essentially it is the same as a *.exe file in Windows.  

Updating a *.deb program depends on the program.  It might be wise to do an 

internet search on how to upgrade your specific *.deb program. 

 

For System Package (APTs) and Flatpak installed apps using the Software Manager, 

use the Update Manager app to check for updates.   
 

For AppImage installed apps usually from the app’s website; use a manual update 

procedure:  
 

If you want to update an AppImage without installing anything extra: 

1. Visit the App’s Website 
o Use your browser to go to the website where you originally downloaded the AppImage. 

2. Download the Latest Version 
o Save the new AppImage file to your preferred folder (e.g., ~/opt).  You may need to use 

the File Manager’s computer folder.  (refer to the Arduino’s installation instructions for 
details on moving to /opt.) 

3. Make It Executable 
o Right-click the new AppImage → Properties → Permissions tab → check “Allow 

executing file as program.” 

4. Replace the Old File 

• Delete or archive the older AppImage file. 

• If you had a menu shortcut, you may need to update it manually using Main Menu 

editor. (Or if the old shortcut does not work, delete it and create a new one.) 
 

Bonus Tip: Check for Built-in Updater 

• Some AppImage programs include their own update feature: 

• Open the app and look for an “Check for Updates” or “Update” option in the 

menu.  (Arduino IDE has its update check under the Help menu.)  

https://itsfoss.com/linux-mint-update/
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8) Use Rescuezilla to backup the hard drive 

Rescuezilla is a backup & restore utility, commonly used in Linux (works on Windows as 

well) systems.  When you create an image backup, you can use it to restore the 

computer, if there is an issue with this computer or to image other computers. 

 

Before making the backup, this is the time to copy your personal files into the Mint computer!   

➢ Two USB drives are needed:   

o USB1 will be made bootable with the Rescuezilla software.  

o USB2 will be a large drive to hold you Rescuezilla backups. 

(If you don’t have two USB ports on your PC, refer to next page for alternatives.) 
➢ USB1 is used for running the Rescuezilla app.  USB2 used for storing the backup file. 

➢ The balenaEtcher app is used to make USB1 a bootable drive.  (We used Rufus 

with the Mint.ISO file earlier because we used Windows to run the Rufus 

software.  balenaEtcher is perfect for Linux computer.) 

 

First: Create a Rescuezilla “bootable” USB1 drive 

Tip: A Tutorial on Rescuezilla: https://www.youtube.com/watch?v=duF6EVc9tuc    

1. Make sure you are logged in with the Admin password. 

2. For the backup program, download the latest stable Rescuezilla .ISO file from 

https://rescuezilla.com/.  

3. For the create bootable USB drive program, download Etcher for Linux (ZIP) 

from: https://etcher.balena.io/  (We used Rufus app on Windows to create a 

bootable drive.  With Linux, we’ll use Etcher to create a bootable drive.) 
4. In the Downloads folder, right-click on the Etcher zip file and select Extract Here. 

(You may get an error extracting the files, just ignore that. 

5. Insert USB1.  Open the new balenaEtcher folder and double click on balena-

etcher program file to launch it.   

a. Flash from File: locate and select the Rescuezilla ISO file.   

b. Select Target: locate and select USB1 as your target drive.   

c. Flash: This will flash USB1 to make it bootable and launch Rescuezilla.  

When the Flash is Completed, close the balenaEtcher program.  You may delete 

the two downloaded files from your Downloads folder.  Keep USB1 inserted. 

 

Second: Create a backup on USB2.  

1. Restart your computer into the USB Boot Menu.  

a. Select the USB1 drive. 

b. Rescuezilla will automatically launch. Wait for the Welcome screen.  

2. Insert USB2, the external drive that will contain the Backup files..   

3. Select Backup; (This will create an image from the hard drive to USB2)  

Step 1: Select the drive to backup, this will by your computer’s hard drive. 

Step 2: Select partitions to save.  Keep all checked, to make a full image backup. 

https://www.youtube.com/watch?v=duF6EVc9tuc
https://rescuezilla.com/
https://etcher.balena.io/
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Step 3: Select the destination drive, which is USB2 

Step 4: Select a Destination Folder, use the Brouse button to select a different one. 

Step 5: Name your Backup, you can use the default or rename it  

Step 6: Customize Compression Settings.  Keep the defaults 

Step 7: Confirm Backup Configurations, check over to make sure it makes sense. 

Step 8: Creating Backup Image.   

4. Wait for the “Backup saved Successfully” message. Select Next when done.  

5. To close Rescuezilla properly, click on the small “Display” icon in the lower left-hand 

corner and select Shutdown.  Select Reboot.  After the reboot into normal Linux Mint,  

Use the Files app to “eject or unmount” all USB drives and save them for future use.  

(Note that USB1 may be labeled “writeable”.) 

 

 

Don’t have “two” USB ports on your computer.  

Here are some options for using Rescuezilla with only one USB port: 
 

    Option 1: Use the “Load USB into RAM” Feature 

Rescuezilla has a RAM-loading option at boot: 

• When you boot from USB1, after selecting your language, choose “Load Rescuezilla 
into RAM”. 

• Once it’s fully loaded into memory, you can remove USB1 and plug in USB2 for the 

backup destination. 

• This works best if your system has at least 4GB of RAM, ideally more. 

 

    Option 2: Use a Powered USB Hub 

If RAM loading from Option1 isn’t viable: 
• Use a powered USB hub to connect both USB drives simultaneously. 

• This avoids power draw issues and gives you flexibility for future workflows too. 

 

       Option 3: Backup to Internal Drive (Temporarily) 

If you’re just trying to get the backup done: 
• Save the backup image to an internal drive partition. 

• Then reboot into Linux Mint and copy the image to USB2. 

• Not ideal for long-term storage, but it works in a pinch. 

 

      Option 4: Use Network Storage 

If you’ve got a NAS or another networked PC 

• NAS stands for Network Attached Storage device. 

• Rescuezilla supports saving backups over the network  

• You can back up to a shared folder and later transfer it to USB2. 

 

Restore a PC procedure – using a backup file created by Rescuezilla:  

If restoration is needed, boot from USB1 and launch Rescuezilla.   

Then insert USB2 and select Restore.  Then follow the prompts.  
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Appendix: 

Resources: Tutorials, Troubleshooting, & Support  

A Historical perspective of Linux Mint: 

Linux was developed in 1991 as a kernel for operating systems. Two years later, the 

Debian Project was founded with tools that run on the Linux kernel.  In 2004, Ubuntu 

was launched as a Debian distribution offering more tools.  In 2006, Linux Mint 

started; its Cinnamon version is based on Ubuntu and its LMDE (Linux Mint Debian 

Edition) is based on Debian. Linux is funded by contributions & corporate support.  

 

Try different Linux distributions – without installing them! 

The https://distrosea.com/ website offers a variety of Linux options you can try 

without installing anything.  Everything runs within your browser.  This website offers 

a tutorial: https://allthings.how/how-to-try-linux-in-a-browser-with-distrosea/  

 

Tutorials: 

• Mint Setup Complete Guide: https://youtu.be/U6nik3bPIGs?si=-KuN3hXZDLHOYnji  

• Mint’s feature playlist of videos: 
https://www.youtube.com/watch?v=kUC9RbrS0q0&list=PLrW4kXWyzgoKKLkdHTH8E5v_JboLeAITi  

• Linux Usage Playlist:  
https://youtube.com/playlist?list=PLjie1qS4xnWhsfRJ5nWL_6S7I-kKf49bf&si=R4CQUkr3Knh6ec-V  

• Other apps?  https://youtu.be/RTwOvogeEVs?si=MLamXyBlUnqDfHMa  

• Linux Gaming – Reddit:  https://www.reddit.com/u/Intelligent-Gaming/s/1FqCqP8Weg 

• Installing WineHQ (for Windows apps running in Linux) 

https://youtu.be/iQ1R9Uv5kgA?si=3-Gbwuox8gEscMge  

• Modernize the Mint interface  https://youtu.be/OwBKbuy7U8s?si=ir-in0QuXg--GD7J  

• Timeshift (system snapshot) tutorial: https://teejee2008.github.io/timeshift/  

• Explaining Computers: https://youtube.com/@explainingcomputers  

• Learn Linux TV: https://youtube.com/@learnlinuxtv 

• Learning Linux ebook: https://github.com/GitJit-max/learning-linux  

• Linux Journey: https://labex.io/linuxjourney  

• Things to think about & learn:  https://itsfoss.com/rookie-linux-mistakes/  

• Beginners Guide for Linux (Distro Watch) (https://distrowatch.com/)  

 
  

https://distrosea.com/
https://allthings.how/how-to-try-linux-in-a-browser-with-distrosea/
https://youtu.be/U6nik3bPIGs?si=-KuN3hXZDLHOYnji
https://www.youtube.com/watch?v=kUC9RbrS0q0&list=PLrW4kXWyzgoKKLkdHTH8E5v_JboLeAITi
https://youtube.com/playlist?list=PLjie1qS4xnWhsfRJ5nWL_6S7I-kKf49bf&si=R4CQUkr3Knh6ec-V
https://youtu.be/RTwOvogeEVs?si=MLamXyBlUnqDfHMa
https://www.reddit.com/u/Intelligent-Gaming/s/1FqCqP8Weg
https://youtu.be/iQ1R9Uv5kgA?si=3-Gbwuox8gEscMge
https://youtu.be/OwBKbuy7U8s?si=ir-in0QuXg--GD7J
https://teejee2008.github.io/timeshift/
https://youtube.com/@learnlinuxtv?si=JaMnAO1QMS9H9SHE
https://github.com/GitJit-max/learning-linux
https://labex.io/linuxjourney
https://itsfoss.com/rookie-linux-mistakes/
https://distrowatch.com/
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Troubleshooting problems:  

• Do Internet searches or use your favorite AI Chatbot. 

• The above Tutorial links are also good troubleshooting sites..  

• Tech Support website: (Excellent learning or just browsing website.) 
https://www.virtualcuriosities.com/articles/4216/linux-faq-for-windows-users-and-linux-beginners 

• Nvidia Driver Tutorial https://www.virtualcuriosities.com/articles/1788/how-to-install-

nvidia-drivers-in-linux-mint 

• Nvidia Driver Installation https://linuxcapable.com/install-nvidia-drivers-on-linux-mint/ 

• Nvidia Driver for GT218 [GeForce 210]: https://forums.developer.nvidia.com/t/driver-for-

geforce-210-under-linux/216538  

• Driver issues in general don’t usually exist. Amazingly most drivers are 

imbedded in the Linux kernel and are even updated. 

• USB serial ports fail to connect. Make sure your username is assigned to 

the dialout (serial port permissions) group.  Open Users and Groups app, then 

click on the username.  In the Groups list, dialout needs to be there. If not just 

click on the list to open the list of groups and check the dialout group.  OK, 

close and re-login. 

 

Just some great information to check out! 
 

❖ What’s your favorite Linux Mint program -  Reddit, r/linuxmint: 
  https://www.reddit.com/r/linuxmint/comments/1o2gvzw/what_is_your_favorite_linux_mint_programs/?  

 

❖ Gaming in Linux –  a discussion on Reddit, r/linux_gaming  
 https://www.reddit.com/r/linux_gaming/  

 

❖ Read a “real” book: This one was published in March 2025, 180 pages 

https://www.amazon.com/Linux-Mint-Quick-Guide-Beginners 

 

  

https://www.virtualcuriosities.com/articles/4216/linux-faq-for-windows-users-and-linux-beginners
https://www.virtualcuriosities.com/articles/1788/how-to-install-nvidia-drivers-in-linux-mint
https://www.virtualcuriosities.com/articles/1788/how-to-install-nvidia-drivers-in-linux-mint
https://linuxcapable.com/install-nvidia-drivers-on-linux-mint/
https://forums.developer.nvidia.com/t/driver-for-geforce-210-under-linux/216538
https://forums.developer.nvidia.com/t/driver-for-geforce-210-under-linux/216538
https://www.reddit.com/r/linuxmint/comments/1o2gvzw/what_is_your_favorite_linux_mint_programs/?
https://www.reddit.com/r/linux_gaming/
https://www.amazon.com/Linux-Mint-Quick-Guide-Beginners/dp/B0F2SYZ4K1/ref=sr_1_1?crid=385SC56VB5TX4&dib=eyJ2IjoiMSJ9.fvJ0X9HN2ubjQKT2pbWotdSSdhRyFnpFYaoMdOiAejK5sRy0Nwifs_MMEPSdqTPDdsw2xVLTFgSc74bNBOXde2SDGt11Z3Ydbcwc-quRDGCQCMNp2aPHcVY1uDM9WQicRHrmA9-YnS4u5N_bS2i0KA.tSk1i9U4xfqFSn_cj3Ue6_18-5V0J9wOv9ridPoCchc&dib_tag=se&keywords=Linux+Mint%3A+Quick+Guide+for+Beginners&qid=1761571258&sprefix=linux+mint+quick+guide+for+beginners%2Caps%2C236&sr=8-1
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Resources:  

What’s happening in Linux these days?  Check out these websites: 

➢ Wikipedia (Better than I thought it would be.) https://en.wikipedia.org/wiki/Linux_Mint  

➢ 9to5 Linux News https://9to5linux.com/?s=Mint  

➢ Its Foss - Customize Desktop  https://itsfoss.com/customize-cinnamon-desktop/ 

➢ It’s Foss - Email Newsletter: https://itsfoss.com/newsletter  

➢ Easy Tips - How to do anything: https://easylinuxtipsproject.blogspot.com/p/1.html  

➢ Known issues: (click on Release Notes) https://linuxmint.com/download.php  

➢ It’s FOSS (Free & Open Source Software) https://www.youtube.com/@itsfoss 

➢ ZDNET Linux page https://www.zdnet.com/topic/linux/   

➢ Wiki site on Reddit: https://www.reddit.com/r/linux4noobs/wiki/index/ ) 

 

Support  

➢ Linux Mint Forums: This is the most active and recommended place for technical 

assistance. It is a community of users and volunteers who answer questions on 

installation, software, hardware, and other topics.  
https://forums.linuxmint.com/ 

 

➢ Linux Mint Documentation: Before posting in the forums, check the official 

documentation on the Linux Mint website. The site provides a user guide, an 

installation guide, and a troubleshooting guide that can help you solve many 

common issues.  
https://www.linuxmint.com/documentation.php  

 

➢ Reddit (r/linuxmint): The Linux Mint subreddit is another active community where 

you can find support and discuss news and information related to the distribution.  
https://www.reddit.com/r/linuxmint/  

 

➢ Computer Repair for your Linux PC: If your Linux computer is not working 

properly, make sure you use a computer repair shop that understands Linux.  The 

Computer Guys near the Southgate Mall is such a computer repair shop. 

https://www.computerguysmt.com/        (406) 542-2800 

1724 Fairview Avenue, Missoula Mt 59801  

 

  

https://en.wikipedia.org/wiki/Linux_Mint
https://9to5linux.com/?s=Mint
https://itsfoss.com/customize-cinnamon-desktop/
https://itsfoss.com/newsletter
https://easylinuxtipsproject.blogspot.com/p/1.html
https://linuxmint.com/download.php
https://www.youtube.com/@itsfoss
https://www.zdnet.com/topic/linux/
https://www.reddit.com/r/linux4noobs/wiki/index/
https://forums.linuxmint.com/
https://www.linuxmint.com/documentation.php
https://www.reddit.com/r/linuxmint/
https://www.computerguysmt.com/
tel:4065422800
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Tips for using Mint 

1) The “LM” Menu button, on the left side of the Panel, is launched by clicking the 
“Windows” key on your keyboard or mouse click on LM panel icon. 
 

2) Here is the Menu layout. Tip: Drag apps in and out of Favorites column at any time. 

 

 

 

 

 

 

 

 

 

 

 

 

3) An easy way to launch an app: Click the LM Menu button, then start typing the 

name of your app.  Once it shows up, you can select Enter. 

 

4) Create a Timeshift prior to major changes. Schedule a Timeshift to create a restore 

point periodically.  It takes up lots of disk space so only keep 2 Timeshift files.  

 

5) Desktop Icon size, Right-click on the desktop; select Customize; Change Icon Size. 

Also try out the sliders… pretty cool. 
 

6) Desktop shortcut, (known as a “Launcher file”) is created by using these methods: 

1. Rt-Click on an app, then select Add to desktop 

2. Select Ctrl + Shift then drag then drag the file to the desktop 

3. Rt-Click on an app and select Create a Launcher file 

 

7) Taking screenshots  
Using the PrtScr key (This is the Print Screen key, on your keyboard) 

• Full screen: PrtScr button, Active Window: Alt + PrtScr   

• Selected area – Shift + PrtScr 
Using the Screenshot app from the Menu. After screenshot is taken:  

• Use the Save button to save to the /Home/<username>/Pictures folder  

• Use the Copy to Clipboard button to paste directly into a program 

The Flameshot screen capture app offers more options. www.flameshot.org  

  

Apps contained in the 

selected Category 

Category column 

Favorites column 

Search field 

Tool Tip of what’s selected 

http://www.flameshot.org/
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8)  Right-Click options – How to edit the list 
In System Settings, there is an Action button found in the Preferences group.  

When selected, you can manage the list, download new entries to the list or 

change the layout.  Here’s a YouTube tutorial: 
https://www.youtube.com/watch?v=ER-Z8bZBWJs  

 

9) Desklets & Applets (small programs you can add to the desktop and panel) 

“Desklets” are apps added directly to the desktop. 

“Applets” are apps added to the bottom right-side of the Panel.  (These are 

managed in System Settings or right-click on Panel.)   

This website to obtain more Themes, Applets, Desklets, Actions and Extensions 

to install on your system. https://cinnamon-spices.linuxmint.com/  

Here’s a good tutorial on making changes to the panel: 
https://youtu.be/m0zV42OId3M?si=HYyZx9RieJgZ8QKk 

 

10)  Become familiar with Terminal: 

The Terminal is a text command interface. Keep in mind that many terminal 

commands can be accomplished using the Mint interface windows.   

Tip: if you are researching something and it says to use a terminal command, 

try googling a Mint GUI equivalent. (GUI = graphic user interface)   
 

Terminal Tutorial: https://www.youtube.com/watch?v=1tEtKMhoBIg  

An Terminal command to try is neofetch. Simply open Terminal and type in neofetch, 

then hit Enter. (Note that terminal commands are lower-case.) This displays your 

computer system information.  Check out some of the Terminal commands in the 

attached Terminal Command Cheat Sheet, located in this Appendix. 

Have Command fun!? https://overthewire.org/wargames/bandit/  

 

11)  Username on the Panel  

Not only do you see who’s logged in but by clicking on it you have an easy way 
to launch system commands; System Settings, Switch Users, Log out and Power 
Off options. Here’s how to get the Username displayed on the Panel. 
 

• Right click on an open area on the Panel, select Applets. (This launches the 
Applets settings window.) 

• Scroll down the alphabetical list and highlight the User Applet; then click the + 
button to add the applet to the Mint system.  Then click on its Gear icon, lo-
cated on the right side. In the User Applet configuration windows, turn on the 
Display username on panel selection. Close the Applet window.  

• Left click on the username in the Panel. (If nothing happens, reboot your PC.) 
There are quite a few handy shortcut commands here.  

• If you wish to move the username to the center of the panel; right-click on a blank 
area in the Panel; turn on the Panel edit mode. Drag the username applet to the 
center green rectangle in the center.  Turn Off to Exit Panel edit mode.  

https://www.youtube.com/watch?v=ER-Z8bZBWJs
https://cinnamon-spices.linuxmint.com/
https://youtu.be/m0zV42OId3M?si=HYyZx9RieJgZ8QKk
https://www.youtube.com/watch?v=1tEtKMhoBIg
https://overthewire.org/wargames/bandit/
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• Troubleshooting: if clicking on icons don’t do anything, then you need to reboot. 
Use the Super key on the keyboard to launch the Menu; select Shut Down, 
then select Reboot. After you log back in, everything should work again.  

12)  Startup Application list:  
Open the System Settings > Startup Applications.  Do you really need them 
all?  (Tip: if you don’t recognize them, do an internet search to see if you can 
disable them or keep them in Startup.) 

13)  Change Cursor color:  
The default black with white border icon can be changed by downloading Ox-
ygen-cursor-theme app from the Software Manager.  Then go to System 
Settings >  Themes > Advanced settings button > Mouse Pointer.  Pick a new 
cursor, like oxy-yellow. 

14)  Hot Corners app: Make the top-left corner “show all windows”. This spreads 
out all your open windows. Now you can launch a window or select the red X 
close it.  
 

15) Memory and Disk Usage! 

• Launch System Monitor > Resources tab 

• For Memory usage: In the Resources tab: Look under Memory and Swap to 
see usage and total system memory. 

• For Disk usage: In the File Systems tab: All disk partitions are shown.  Look un-
der the Directory column for the root directory (/).  There is the total and availa-
ble disk space.  Also, a bar graph is shown.   Another app to view the disk us-
age is the Disk Usage Analyzer app. 

 

Note: Notice that there are no Drive letters, like in Windows.  Drives are “mounted” in 
Linux not labeled. Run the Terminal command: lsblk to see the mounted location. 

 
16)  Manager Update Notifications 

Apps and the operating system, Mint, do not coordinate their software updates, 

like Microsoft and Apple do. Apps are more independent in Linux. So, it may ap-

pear that every time you launch Mint, an update will be waiting for you.  You can 

control this by following these tips: 

1) Open the Update Manager > Edit > Preferences 

2) Options tab, turn on the two Interface on/off sliders, change to “days” op-
tions in the Auto-refresh group that suits your needs 

3) Automation tab: I would recommend settings some of these only after 

you have a high confidence in using Linux Mint.  It’s a learning experi-
ence to see what updates are coming in.  When you’re ready, you can set 
these automatic install settings.   

17)  (Advanced) Customization Guide YouTube video of Linux Mint 

https://www.youtube.com/watch?v=RazY9BdCRQw  
 

18)  

  

https://www.youtube.com/watch?v=RazY9BdCRQw


Linux Mint Install Setup and Tips _10.27.2025.docx  Page 31 of 41 

Keyboard Shortcuts in Mint 

More shortcuts can be found at: https://cheatography.com/shakiestnerd/cheat-sheets/linux-mint-cinnamon/  

Power button Tap to open Shut Down window, then Enter to shutdown 

Esc Usually closes a dialog box 

F2 Rename in Files app 

Alt + Tab Cycle through open windows 

Alt + F2 Run Command window  (r command = reset Mint display 

Alt + F4 Close window 

Win + up arrow Maximize window 

Ctrl + Alt + Delete Switch Users and Log Out 

Ctrl + 2 fingers slide Zoom in/out  (or Scroll mouse wheel forward/backward) 

Backspace or 

Alt + Left Arrow 
Go Back to previous (The Backspace does alone sometimes) 

Alt + Ctrl + Backspace Resets the current session. Try this if the computer locks up 

or gets stuck in the Administrator Login screen. . 

Alt + PrtScr +reisub This is a “hard reset”. While holding down Alt + PrtScr, press 

reisub letters.  Wait about 30 seconds, your PC should reboot. 

Superkey + D Minimize windows (Show Desktop) 

Alt + Ctrl + T Opens Terminal: 

• Ctrl + Shift + C = Copy in Terminal  

• Ctr l+ Shift + V = Paste in Terminal  

Comparison chart for APT (deb), Flatpak and AppImage files 

Keep in mind that a “program” you want may be packaged differently and offered by 

different repositories. 

 

(Here’s a tutorial video on AppImage files: https://www.youtube.com/watch?v=wHdMhFnnVOI  

 

 APT (.deb) Flatpak AppImage 

Installation 
Termain commands 

or Software Manager 

Software Manager 

or Flatpak install 

Just download, enable 

execution permission and 

run. No installation needed 

System 

Integration 

Deep system 

integration; config 

files stored in 

standard locations 

Isolated from 

system unless 

permissions 

granted 

Minimal integration; runs as 

a portable (standalone) app 

Updates 
Centralized with APT 

update  

Separate update 

system via Flatpak 

update 

Manual; no auto-updates 

unless using external tools 

  

https://cheatography.com/shakiestnerd/cheat-sheets/linux-mint-cinnamon/
https://www.youtube.com/watch?v=wHdMhFnnVOI
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Common Apps 

 

• Microsoft Office: 

o Staying with Microsoft Office, you can run it on Mint.  You need to use the “online” 
version of Microsoft Office. Go to https://www.office.com/ 

o The Office equivalent, LibreOffice is preinstalled with Linux Mint.   

 

• Windows apps running directly in Linux:  

You can install Windows apps using Wine or Bottles apps.  But It’s a more complex 

topic than we will not discuss here. Do your research. Try these Wine Tutorial videos: 

▪ https://www.youtube.com/watch?v=pXnx-KUwAg0  

▪ https://youtu.be/pXnx-KUwAg0?si=SYwboVDuyl19Znpt 

o Website for Wine Terminal commands: https://wiki.winehq.org/Ubuntu  

o The Web Apps app can connect to URLs that you currently use. 

 

• This website suggests alternatives for many apps:  https://alternativeto.net/  

 

• This website can be a great resource for you to find equivalent programs: 

https://itsfoss.com/essential-linux-applications/  

https://www.linux.com/training-tutorials/linux-migration-guide-finding-linux-equivalents-your-favorite-windows-programs/  

 

• Cloud Storage options: 

o Google Drive & Microsoft  

o OneDrive requires their account logins. 

o Dropbox is simple and easy in Linux 

o Filen, https://filen.io/  -  They offer a free 10Gb cloud service 

 

 

  

  

https://www.office.com/
https://www.youtube.com/watch?v=pXnx-KUwAg0
https://youtu.be/pXnx-KUwAg0?si=SYwboVDuyl19Znpt
https://wiki.winehq.org/Ubuntu
https://alternativeto.net/
https://itsfoss.com/essential-linux-applications/
https://www.linux.com/training-tutorials/linux-migration-guide-finding-linux-equivalents-your-favorite-windows-programs/
https://filen.io/
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Here are some common Windows programs and Linux applications: 
 

Windows Linux Mint 

Adobe 

Adobe Premiere – DaVinci Resolve 

Adobe Photoshop – GIMP, Krita 

Adobe Acrobat Pro – PDFSam 

https://github.com/KenneyNL/Adobe-Alternatives  

https://penpot.app  

Autodesk AutoCAD FreeCAD, LibreCAD 

Browsers 
Firefox is the default for many Distros.  You can use any 

browser if you wish 

Cloud storage OneDrive, Google Drive, Dropbox 

 File History and 

 System Backups 

Backup Tool (for” file” backups) 

RescueZilla (for full harddisk image backup) 

Gaming 

Install Steam… 

https://thelinuxcode.com/install_steam_linux_mint/   

https://forums.linuxmint.com/viewtopic.php?t=404412  

https://www.protondb.com/  

Microsoft Office LibreOffice (default in Mint), or OnlyOffice 

Notepad Xed  

Outlook Thunderbird (you can connect to Yahoo or Gmail accounts) 

Paint 
Pinta (The Drawing app offers more capabilities.) 

Paint.js.org (A paint website, no download requrired.) 

PDF Viewers Document Viewr (Okular is a popular PDF viewer & presenter) 

Steaming apps Can be used in your browser instead of a download. 

System Report 

Menu > System Reports > System Information 

Terminal command: neofetch 

Resources app and the Stacer app  

Task Manager System Monitor (Downlaod Mission Center for more info) 

Video / Music / Games 

VNC (video & music)  Steam for Gaming 

https://itsfoss.com/non-violent-games-llinux/  

Clemintine app – music player 

Video Editor 
Kdenlive https://kdenlive.org  (AppImage or Flatpak available) 

Others: Shotcut, Divinci Resolve, Opencut or Filmora  

Windows Security ClamAV (Refer to Tips document for security discussion) 

  

https://github.com/KenneyNL/Adobe-Alternatives
https://penpot.app/
https://thelinuxcode.com/install_steam_linux_mint/
https://forums.linuxmint.com/viewtopic.php?t=404412
https://www.protondb.com/
https://itsfoss.com/non-violent-games-llinux/
https://kdenlive.org/
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Uninstalling Apps:  

In many cases, you can use the Menu to locate the program you wish to remove, 

then right click on it to select uninstall.  Keep in mind that if there is a Desktop icon 

for that program, it may not automatically be deleted; so right-click on the icon to 

delete it manually. 

 

For APT and Flatpak installed apps, using Software Manager to uninstall them. 

Apps that were installed using Software Manager, which are the System 

Package APT and the Flatpak package installed apps can use Software Manager 

to remove, or delete them. 

1. Open Software Manager. 

2. Select the hamburger 3-line icon. 

3. Select the Show installed applications. 

4. Select the app you wish to uninstall. 

5. Select the Remove button.  (Select Continue in the Additional software will 

be removed window) 

6. If the desktop icon remains, you can right-click on it and select Delete or 
Move to Trash. 
 

For Applmage installed apps, use this “manual removal” process  

1. To delete an Applmage file, the process can be a bit complex than APT or 

Flatpak program.  (Keep in mind that apps installed using Software 

Manager’s install packages do not use Applmage.  They are deleted from 
the Software Manager.)   

2. Try this terminal command to delete an Applmage file from the /opt folder. 

3. sudo rm /opt/FILENAME  

4. (Replace FILENAME with the name of the Applmage including its file 

extension. So, from Files > /OPT folder, right-click on the file and select 

Properties.  Then copy the Name. Finally, paste it into Terminal.) 
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Web Apps app 

This method of taking a website (like YouTube, Outlook, or ChatGPT) and turning it into an 

app-like shortcut. That shortcut opens in its own window—no tabs, no browser distractions. It 

sits in your menu like other apps, and you can add it to the panel or desktop. 

 

What are Web Apps? 

Web apps are applications that run in a web browser, allowing users to access them 

without installation. They provide functionality like traditional desktop applications but 

are more flexible and accessible. 

Popular Examples of Web Apps 

Web App Description 

Google Docs An online word processor for creating and editing documents. 

Gmail A web-based email service for sending and receiving emails. 

Facebook A social media platform accessible through a web browser. 

Netflix A streaming service for movies and TV shows. 

Twitter A platform for sharing short messages and updates. 

 

Using Web App Manager in Linux Mint 

Linux Mint's Web App Manager allows users to convert websites into standalone 

applications. Here’s how to use it: 
1. Install Web App Manager: Download and install it from the Linux Mint blog. 

2. Create a Web App: 

o Open Web App Manager. 

o Click the “+” icon to add a new website. 
o Enter the URL and customize the app's name and icon. 

o Save the app, which will now appear in your system menu. 

3. Access and Manage: Launch the web app like any other application. You can 

pin it to your panel or desktop for quick access. 

This process enhances the user experience by providing a more app-like feel to web 

applications, making them easier to use on Linux Mint. 

 

 

Online Accounts app 

The Online Accounts app lets you connect to your Google, and Microsoft, accounts 

from  your Linux Mint system. Once connected, your email, calendar, contacts, and 

files from those services can automatically sync with Mint’s built-in apps.  This app 

uses the browser in Mint to connect to your other accounts.   
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What’s the difference between Online Accounts and Web Apps? 

➢ Use Online Accounts when you want your cloud data to work inside Mint’s apps. 

➢ Use Web Apps when you want quick access to websites without opening a browser. 

 

        Online Accounts vs. Web Apps in Linux Mint  

 

Feature    Online Accounts App   Web Apps App 

Purpose 
Integrates cloud services 

with system apps 

Turns websites into 

standalone desktop apps 

Examples Google Drive, Microsoft 365 Gmail, Outlook Web, Spotify 

System 

Integration 

Deep: syncs with Calendar, 

Files, Mail, etc. 

Shallow: opens in browser-like 

window 

Data Access Native access via Mint apps Web-based access only 

Offline Use 
Possible (e.g., 

email/calendar sync) 

Limited or none, depends on 

site 

Privacy Control You choose what to sync 
It depends on website’s own 
privacy settings 

Setup Complexity 
One-time login, then 

automatic sync 

Manual creation of each web 

app 
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Windows VM on Linux for Apple iTunes 

(I found this on the internet.  I have not tried it out, so let me know if you try it. Thanks Dan) 

Installing a Windows Virtual Machine on Linux Mint for iTunes Use 
This guide explains how to install a Windows virtual machine (VM) on Linux Mint using 

VirtualBox. The purpose is to run iTunes for tasks like full iPhone backups, restores, and 

iOS updates, which are not fully supported by Linux tools. 
 

Recommended Windows Version 
We recommend using Windows 10 (64-bit) for compatibility with iTunes and VirtualBox. 

Windows 10 remains stable, receives updates, and runs well in a virtual machine. You 

can use a legitimate ISO from Microsoft’s website. 
 

Prerequisites 
1.  A Linux Mint computer with at least 8 GB RAM and 40+ GB of free disk space 

2.  VirtualBox installed (can be installed via Software Manager or Synaptic) 

3.  Windows 10 ISO file (downloadable from Microsoft's official site) 

4.  iTunes installer for Windows (downloadable from Apple.com) 
 

Steps to Set Up the Windows VM 
1.  Open VirtualBox on your Linux Mint system. 

2.  Click 'New' to create a new virtual machine. 

3.  Enter a name (e.g., Windows 10), set the type to 'Microsoft Windows' and version to 

'Windows 10 (64-bit)'. 

4.  Allocate memory (RAM). Recommended: 4096 MB (4 GB) or more. 

5.  Create a virtual hard disk (at least 40 GB). Choose VDI and dynamically allocated. 

6.  After creation, go to Settings > Storage. Select the empty optical drive and load the 

Windows 10 ISO. 

7.  Start the VM and follow the Windows installation process. 

8.  Once Windows is installed, install Guest Additions (Devices > Insert Guest Additions 

CD Image). 

9.  Download and install iTunes from Apple’s website within the VM. 
10. Plug in your iPhone and allow USB passthrough to the VM (Devices > USB > Your 

iPhone). 

Tips and Notes 

• Enable USB 2.0/3.0 support in VirtualBox’s VM settings (install the Extension Pack if needed). 
• Make sure to 'Trust' the computer when prompted on your iPhone. 
• You can take snapshots of the VM to preserve working states. 
 

Conclusion 
By setting up Windows 10 in a virtual machine, you can access the full functionality of 

iTunes while keeping Linux Mint as your main operating system. This hybrid setup offers 

the best of both worlds. 
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Security and Anti-Virus  

In the Windows world, security and anti-virus software are all the rage. Why 

Windows and not Linux? Windows is an easy target since it’s the most popular 
Operating System in the world and there’s only one version of it. Linux has about 5% 
of the PC market and there are hundreds of different distributions of Linux.   

 

So, what’s happening in the Linux world?   
• You can still get malware from email links and social media.  Be aware! 

• There really is no “one distribution” of Linux; there are many!   

• App stores, like Software Manager in Linux Mint, contain apps that have the proper 

verified package containers.  Try to stay away from website app downloads. 

• Learn more about Linux security: 
https://easylinuxtipsproject.blogspot.com/p/security.html 

ClamAV Antivirus app install & operation: 

The ClamAV app is a “terminal-based” virus scanner most often used by Linux home 

users. The ClamTK app is a GIU interface for the ClamAV antivirus app, making it a 

lot easier to use.  

• ClamTK Installation:  

o Open Terminal. Then type in  sudo apt install clamtk 

o Type in your admin password, to perform the installation. 

o Type Y for yes to continue with the installation. 

• Try opening ClamTK from the Menu. It should launch. 

• Then in ClamTK > Settings: check all the options for maximum scan protection. 

(To learn what these options mean, you can take a snapshot of the Virus Scan-

ner window, then launch your AI chatbot, and paste in the screen capture and 

ask what all these options mean? 

• Click on Scan a directory; it defaults to the Home/username folder.  This is ok but 

for a full scan of your computer, back up to the root folder (looks like a small 

square with circle in it.  Then click OK to start the scan.  (If you do a full scan with 

all scan options, it can take a while.) 

• Add ClamTK to the Other category in the Menu: 

o Right-click on Menu icon, then select Edit Menu 

o Left-click on Other, then click New Item button 

o In the Launcher Properties,  

▪ In Name, type in ClamTK antivirus  

▪ In Command, type in clamtk   (note that all commands are lower case)  

▪ Click Ok, then Close the menu editor.  Open Menu > Other  

• It also allows a “Scan for threats…” option in the File manager app. To scan just one 
folder, right-click on it in the Files app  and scan its contents. 

Security Mistakes Linux users make: https://youtu.be/QxNsyrftJ8I?si=YI2zThNFVqijPAPL  

https://easylinuxtipsproject.blogspot.com/p/security.html
https://youtu.be/QxNsyrftJ8I?si=YI2zThNFVqijPAPL
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Password Managers: 

A browser’s Password Manager feature. (Firefox even uses a Master Password) 

Here are some more powerful Password Manager programs: 

Program Type Highlights Ideal For 

Bitwarden Cloud  Open source Simplicity 

KeePassXC Offline Local vault  
Privacy-focused 
users,  

Buttercup Hybrid Simple UI Middle ground 

1Password Proprietary Linux app Advanced users 
 

 

 

Anti-Virus software: (If you decide to use one; here are some examples) 

Program Key Features Best For 

ClamAV Free and open source Basic home users 

Bitdefender  Affordable pricing Comprehensive system check 

Avast  Excellent real-time file scanner-  File servers and dual-boot setups 

 

 

For “over-security” conscious folks: here are some suggestions:  

* Keep the system up to date & turn on the Firewall. (Best advice to give anyone) 

* Run the Brave browser. If not Brave, run Firefox with "NoScript" mode. 

* Portscan your device from another machine: disable or secure services and firewall them 

* Use Tripwire, Apparmor, Selinux, etc.  (useful for advanced Linux server systems) 

* Scan untrusted binaries with ClamAV or some other AV software. 
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Terminal Command Cheat Sheet 

This is a quick-reference guide to common Terminal commands.   

Note: The command name SUDO is an abbreviation for Superuser Do.  

(It’s an administrator command used in Terminal.) 

 

Here are a couple websites to learn Terminal commands for the beginner: 
https://linuxconfig.org/basic-linux-commands, https://itsfoss.com/linux-terminal-shortcuts/  

Want a game to learn commands? https://overthewire.org/wargames/bandit/  

 

    File and Folder Basics 

Task Command Notes 

User’s home director 
(shortcut symbol) 

~ (Tilde) 
cd ~ 

The Tilde is a shortcut to the 

user’s home directory: 

/home/username 

List files in a folder Ls Like `dir` in Windows 

List files with details ls -l The -l display details 

Go to a folder cd foldername Like `cd` in Windows 

Move back on folder cd ..  

Current folder pwd Print (display) Working 

Directory 

 

      System Info and Cleanup 

Task Command Notes 

Show system info in 

nice format 

neofetch If it’s not installed, you may need to 

run sudo apt install neofetch first 

Show disk usage df -h Shows storage in human-readable 

form 

Show RAM usage free -h How much memory is being used 

Clean up unused 

packages 

sudo apt 

autoremove 

Frees space from old dependencies 

Live Resource Monitor top Shows real-time CPU memory and 

process usage. 

Linux Distribution 

information 

cat /etc/os-

release 

Names for Mint and Ubuntu are 

displayed 

 

  

https://linuxconfig.org/basic-linux-commands
https://itsfoss.com/linux-terminal-shortcuts/
https://overthewire.org/wargames/bandit/


Linux Mint Install Setup and Tips _10.27.2025.docx  Page 41 of 41 

Reinstalling Windows 10 (this removes Linux) 

If you wish to return to the Windows Operating System, here are two possibilities. 

 

1) If you made an image backup of your Windows PC prior to installing Linux, you can 

use that same backup software to “Restore” the image back to your PC.  Thus, 

wiping out  the Linux installed distro software. 

 

2) If you do not have an image backup, follow these steps below: 

   Step-by-Step: Reinstalling Windows 10: 

 

You will need to have a USB flash drive for this process. 

1. Download Windows 10 “Media Creation Tool” 

o Go to https://www.microsoft.com/software-download/windows10  

o Click “Download tool now” 

2.  Create a Bootable USB Installer 

o Run the Media Creation Tool on a Windows machine 

o Choose “Create installation media (USB flash drive)” 

o Select your language, edition, and architecture (64-bit is standard) 

o Plug in your USB and let the tool format and prepare it 

3.  Boot from the USB on Your Linux Mint Laptop 

o Insert the USB into your laptop 

o Restart and enter the boot menu (usually by pressing F12, Esc, or Del 

during startup) 

o Select the USB drive as the boot device 

4.  Install Windows 10 

o You will probably need the Key value from the original installation of 

Windows 10. (Refer to the first section of this document, “Obtain 

Windows 10 Key before Mint Installation”.) 

 

 

https://www.microsoft.com/software-download/windows10
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